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Critical Path Analysis of Command and Control 
Support 

EXECUTIVE SUMMARY 

The Command and Control (C2) Support Study (C2SS) was established to assess the 
strengths and weaknesses of ADF C2 support (C2S) and in Phase III analyse options 
for addressing the identified weaknesses (inadequacies). Phase II of the C2SS has 
recently been completed. Scope for employing critical path analysis capabilities to 
assist the C2SS in data management, reporting and analysis has been determined. This 
document conveys the capabilities and associated opportunities through the use of a 
collection of unclassified examples based on invented data for a Defence Of 
Australia (DOA) scenario used in the C2SS. 

Critical path and cost analysis are typically intrinsic features within commercial 
project management tools. Microsoft (MS) Project was chosen for this investigation 
owing to its availability and user familiarity. It provides an ability to: 

• Construct a hierarchical representation of an ADF scenario or structure with 
associated C2S inadequacy values and remedial cost figures. 

• Employ a flexible model design through the use of sub-projects and C2S 
primitives. 

• Automatically generate and visualise critical areas of C2S inadequacy at 
various levels of abstraction in the model hierarchy. 

• Vary inadequacy values and cost for the purposes of cost-benefit and other 
analysis. 

The benefits of using critical path analysis become increasingly apparent with growth 
in model complexity. Applying critical path analysis to the C2SS data gathered to date 
will generate some data management and visualisation benefits but is unlikely to 
reveal any results that are not already evident. A complex model might consist of the 
hierarchical breakdown of a scenario into various operational phases and stages 
therein, introduction of specific agencies associated with each phase and stage, and 
inclusion of specific command support and telecommunication systems associated 
with the provision of C2S. 

The following structure might be used for the study of C2S in a DOA scenario. 



DSTO-TR-0678 

DOA 

Decision 
to Deploy 

T T 
Dep Emp 

SA 

c 
o > 
V   0) 

O 

a a 
< 
> o 
O 

(0 a. 
O 

I 
I 

Dep Emp 
LO 

Redeploy 

a. c o 
a 
0) a 

CDF 
cose 
HQADF 
COMAST 

The top-level DOA project for this example is shown below and indicates (for 
the invented data used) that "the critical inadequacy in CIS occurs during the 
Decision To Deploy pltase". 
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Drilling through the hierarchical model might present (see figure below) that "the 
Options Development stage (of the Decision to Deploy phase) is critical owing to inadequate 
CIS to the contributions of CDF and COMAST". Further interrogation might reveal that 
the main inadequacies occur in support to the conveyance of commander intent. 
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It should be noted that there are dangers in applying quantitative analysis tools to 
essentially qualitative data. Two values of inadequacy must be comparable for the 
critical path algorithm to produce meaningful results. 'Apples must be compared with 
apples' in order to state that a certain C2S layer is critical compared with another 
because it has a value of 3 and the other 1. This condition is assumed to be satisfied in 
that even qualitative rating schemes must aim for consistency. 

This report is the result of an initial effort to identify opportunities for supporting the 
C2SS, or some post-study activity, with more quantitative analysis using modelling 
and simulation. 
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1. Introduction 

The Command and Control (C2) Support Study (C2SS)[1,2] was established to 
assess the strengths and weaknesses of ADF C2 support (C2S) and in Phase III 
analyse options for addressing the identified weaknesses. Phase II of the C2SS 
has recently been completed. Scope for employing critical path analysis 
capabilities to assist the C2SS in data management, reporting and analysis has 
been determined. This document conveys the capabilities and associated 
opportunities through the use of a collection of unclassified examples based on 
invented data for a Defence Of Australia (DOA) scenario. 

This report is the result of an initial effort to identify opportunities for 
supporting the C2SS, or some post-study activity, with more quantitative 
analysis using modelling and simulation. 

2. Command and Control Support Study 

2.1 Aims 

The aims of the C2SS are[l,2]: 

(a) To assess the extent to which the new ADF Command Arrangements can be 
supported by the current, planned and government approved ADF C2S 
capabilities; 

(b) To determine the major capability strengths, limitations, inefficiencies and 
redundancies in the ADF C2S capabilities; and 

(c) To develop and assess a range of broad options, including indicative costs, 
which redress identified capability limitations, inefficiencies and redundancies 
in the ADF C2S capabilities. 

Phase I of the study involved scoping of and approach to the study objectives 
with a conceptual model of C2S being derived. Under Phase II several 
operational scenarios were examined using the model in order to research and 
assess ADF C2S capabilities. The study is currently at Phase III where a more 
general assessment of C2S will be conducted as well as options for addressing 
C2S inadequacy. 

2.2 Overview of C2S model 

References 1 and 2 contain details of the conceptual models developed under the 
C2SS; what follows is an overview. C2 support is represented by 5 layers as 
shown in Figure 1. 
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C2 Frameworks 

C2 Processes 

Info Management 

Info Technology 

Telecommunications 

Knowledge Bearers 

Information Bearers 

Data Bearers 

Figure 1: Layers ofC2 Support 

From reference 1 the definitions of each Layer of CIS are: 

"The C2 Framework (C2F) bounds and guides the C2 Process (C2P). It outlines 
the C2 organisation, high level objectives, key positions and responsibilities. A 
C2 Process addresses how the C2 Framework is implemented. Key sequences of 
activities are derived and characteristics of how the C2 organisation operates 
identified. 

Information Management (IM) addresses the capture, storage and retrieval of 
information. C2 Processes are responsible for the manipulation of information. 
Information Technology (IT) can provide support to the C2 Process and 
Information Management. Knowledge of C2 Processes may be embedded within 
computer systems and stored electronic information. Telecommunications (T) 
permit the transfer of electronic information as data streams." 

An effort was made in the C2SS to identify generic characteristics or factors of 
C2. A Transformation/Intent model of C2 was developed for the C2SS and is 
shown in Figure 2. 
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Figure 2: Transformation/Intent model ofC2 

The C2 model is made up of three C2 Factors[l]: 

(i) The Transformation (Tr) Factor concerns the assessment of relevance of 
events or occurrences. Relevance can be to processes, practices or to 
commander's intent. 

(ii) The Inform (I) Factor is a linking factor concerning the conveyance of 
assessments. 

(iii) The Command/Intent (C/I) factor concerns the exercising of command 
and the conveyance of intent resulting in the creation of actions and tasks. 

2.3 Assessing C2S 

In assessing the degree of C2S, the term Inadequacy was used where: 

Inadequacy = Required level of C2S - Present level of C2S . 

In the case where no C2S was currently present, inadequacy was termed Critical 
Absence. Where some level of C2S was present, inadequacy was referred to as 
Insufficient Depth. 

For the considered operational scenarios and elements within, both the 
required and present levels of C2S were rated between 0 and 3. Values of 
inadequacy also therefore have the same range. Zero inadequacy indicates that 
all C2S requirements are satisfied by present levels with a value of 3 
corresponding to the highest level of critical absence. 
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2.4 Indicative Phase II analysis: Defence Of Australia 

A mock Defence Of Australia (DOA) scenario will be chosen throughout this 
report. The data for this scenario has been invented but conveys the nature of the 
analysis conducted during Phase II of the C2SS[2]. The five levels of command 
used in the C2SS will be adopted, namely: 

National Strategic; 

Military Strategic; 

Operational; 

Tactical; and 

Sensor. 

Figures 3 to 7 show values of inadequacy for each layer of C2 support within 

each C2 factor of the five levels of command. 

National Strategic 

Figure 3: C2 Support data for National Strategic Level of Command 

Military Strategic 

C2F C2P   IM      n      T    C2F C2P   IM     IT      T    C2F C2P   IM     ff      T 
Tr I C/l 

Figure 4: C2 Support data for Military Strategic Level of Command 
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Operational 

C2F C2P   IM     rr      T    C2F C2P   IM     IT      T    C2F C2P   IM     fT      T 
Tr I C/l 

Figure 5: Cl Support data for Operational Level of Command 

Tactical 

■2    1 

Figure 6: C2 Support data for Tactical Level of Command 

Sensor 

C2F C2P   IM      FT      T    C2F C2P   W     IT     T    C2F C2P   IM 
Tr I C/l 

rr    T 

Figure 7: C2 Support data for Sensor Level of Command 

3. Scope of Critical Path Analysis 

The C2SS identifies the key organisational structures and C2 processes associated 
with particular scenarios of significance to Australia. It is planned to identify 
opportunities for complementing the study with more quantitative analysis 
using modelling and simulation capabilities. In initiating this identification, 
scope for applying critical path analysis was found. 
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In its conventional use, the critical path method (CPM) is applied to a time- 
scaled network of activities (a 'project') in order to determine which activities are 
critical to the completion over time of that project. Critical activities can be 
regarded as those activities that have no flexibility in their durations; an increase 
in duration in such activities results in a direct and equivalent increase in project 
completion time. Various costs can be associated with an activity, eg fixed costs, 
resourcing rates, penalties. The CPM acts upon deterministic data; criticalities 
within projects which involve probabilistic time delays for activities can be 
inspected using the Project Evaluation & Review Technique (PERT) [4]. 

Applying the CPM to the C2SS involves using C2S inadequacy values in place 
of activity duration times in order to identify the corresponding critical areas of 
C2S. Costs can also be assigned to specific C2S layers and permit some form of 
cost benefit analysis to be conducted in terms of inadequacy reduction. 

There are dangers, however, in applying quantitative analysis tools to what is 
essentially qualitative data. Two values of inadequacy must be comparable for 
the critical path algorithm to produce meaningful results. 'Apples must be 
compared with apples' in order to state that a certain C2S layer is critical 
compared with another because it has a value of 3 and the other 1. This condition 
is assumed to be satisfied in that even qualitative rating schemes must aim for 

consistency. 

An important part in realising the benefits of this capability will be addressing 
the C2SS scenarios in more detail. Applying critical path analysis to C2SS data 
conveyed in reference 2 will generate some data management and visualisation 
benefits but is unlikely to reveal any results that are not already evident. 

Two implementation technologies were considered; a commercial project 
management tool and Petri net simulation. The former offers a more complete 
and user-friendly environment and for this reason was chosen to convey the 

critical path analysis capability. 

4. Project Management Tool Capabilities 

A commercial project management tool is generally heavily tailored to 
conventional projects involving tasks with durations of time. Microsoft (MS) 
Project is one such commercial product. In order to apply such a product to the 
study of C2S, the parameter 'time' needs to be replaced with 'inadequacy' which 
necessitates tailoring and the adoption of certain equivalencies in terminology 
which are displayed in Table 1. In the remainder of this report the C2S 
terminologies will be mainly used. 
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MS Project Terminology Equivalent C2S Terminology 

Tasks 
(Can be work items, milestones, summary 

tasks,...) 

Day 

Model Items 
(Representing C2S Layers, C2 Factors,...) 

Unit Inadequacy 

Task Duration (days) 

Total Duration (days) 
(Calculated for projects, sub-projects and 

summary tasks) 

Inadequacy 
(Entered for each C2S Layer) 

Critical Inadequacy 
(Calculated for whole C2S model or 

components within) 

Resource Cost ($ per day) 

Task Cost ($) 

Total Cost ($) 
(Calculated for projects, sub-projects and 

summary tasks) 

Unit Cost ($K per unit Inadequacy) 
(Cost of Addressing Inadequacy) 

(Entered for each C2S Layer) 

Inadequacy Cost ($K) 
(Calculated for each C2S Layer) 

Total Inadequacy Cost ($K) 
(Calculated for whole C2S model or 

components within) 

Table 1:       Terminology equivalence between project management tools and C2S model 

In order to convey the potential applicability of MS Project to the C2SS, a subset 
of the DOA scenario will be represented first followed by a full representation. 

4.1 Representing the basic elements of C2S 

4.1.1 The project environment 

Figure   8   shows   the   MS Project   representation   of   the   National   Strategic 
component of the DOA scenario data; ie that conveyed in Figure 3. 
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The View mode (see Appendix A) is that of a standard Gantt Chart. This 

environment consists of two main sections. 

(i)    Tabular section: located on the left and listing the model items plus 

associated: 

• Individual or Critical Inadequacy values; 

• Inadequacy 'slack1; 

• Unit cost; and 

•        Inadequacy Cost. 

This format of the Tabular section results from use of a customised 
InadequacyCost table (see Appendix A). Notes can be placed against each entry 
in the table and enables, for example, a record to be made of the rational behind 
the derivation of Inadequacy and associated cost figures. 

(ii) Bar chart section: in the standard Gantt chart form. For each model item 
there is a corresponding bar indicating associated Inadequacy figures. Linkages 
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between model items are visualised; note that the C2S factors (Transform- 
Inform-Command/Intent) are considered sequential. 

4.1.2 Representing the C2S layers 

Each C2S layer (C2F, C2P, IM, IT, T) is represented as a model item. Since there is 
no intrinsic sequence to these layers, the associated model items are considered 
concurrent and hence have no corresponding linkages. 

4.1.2.1 Inadequacy of each C2S layer 

Each C2S layer has associated values of Inadequacy between 0 and 3 that are 
entered by the user. C2S layers with an inadequacy of zero appear as project 
milestones in the Gantt chart but are treated in the same manner as other C2S 
layer items with non-zero inadequacy which appear as bars. 

4.2.2.2 Inadequacy Slack 

The Inadequacy Slack for each C2S layer is calculated and is an indication of how 
much the inadequacy of the layer can be increased before becoming critical (see 
later). 

4.1.2.3 Unit cost for each C2S layer. 

The cost per unit inadequacy is input by the user for each C2S layer. This is 
considered to be the cost of addressing a unit of inadequacy for a specific C2S 
layer. The assumption here is that a linear relationship holds; eg that addressing 
an inadequacy of 2 will cost twice as much as removing an inadequacy of 1. 

4.1.2.4 Inadequacy Cost of each C2S layer. 

The Inadequacy Cost for a C2S layer is calculated by a macro (see Appendix A) 
based on the associated values of inadequacy and unit cost. Figure 8 shows the 
complete allocation of cost rates and resultant inadequacy costs. The Inadequacy 
Cost is interpreted as the cost of addressing the total inadequacy of the C2S 
layer. 

4.1.3 Representing the C2 Factors 

Each of the Transform, Inform and Command/Intent factors are also represented 
as model items. The C2 factors are summary items that span across the five C2S 
layers within the factor and hence have no associated unit cost (a value of zero is 
shown). The Inadequacy value for a C2 factor corresponds to the maximum 
inadequacy of the C2S layers within, ie the Critical Inadequacy of that C2 factor. 
The Inadequacy Cost for a C2 factor is the total of the Inadequacy values for the 
C2S layers within; this is interpreted as the cost of addressing all inadequacy 
within the C2 factor. 

The sequential transition from Transform to Inform to Command/Intent 
(shown in Figure 4) is represented by linkages between the C2 Factor model 
items. The linkages are visualised in the Gantt chart of Figure 8. 
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4.1.4 Total model costs and critical inadequacies 

A model item corresponding to the overall model is used; in this case (Figure 8) 
it is labelled "National Strategic". This item is again a summary item which spans 
across the complete hierarchy of model work items. The Inadequacy value here 
is the total Critical Inadequacy and equals the total of inadequacies along the 
critical 'path'. The Inadequacy Slack will always be zero for total model items 
(except maybe in cases where the project is a sub-project, discussed later). The 
Inadequacy Cost of the total model is simply the total Inadequacy Cost; ie the 
total cost associated with removing all inadequacy. 

4.1.5 Critical path analysis 

Within a C2 Factor the notion of criticality applies to the C2S layer(s) with the 
greatest Inadequacy; ie that (those) that most hinder 'completion' of the C2 
factor. Across the whole model the same notion applies. The critical C2S layers in 
the model are automatically (see Appendix A) identified by MS Project and have 
been set up such that the item name appears red, bolded, italicised, underlined 
and slightly larger than other item names. The Inadequacy Slack is zero for the 
critical C2S layers. For the example concerned the model shows that "in a DO A 
scenario at the National Strategic level of command, the critical inadequacies in C2S are 
in Information Technology to support the Transform process, Telecommunications to 
support the Inform process, and C2 Framework to support Command and Intent". These 
critical layers are shown in Figure 8 and correspond to the inadequacy peaks in 
Figure 3. 

Changing Inadequacy figures for C2S layers will automatically regenerate the 
new critical C2S layers. For example, changing the Inadequacy of 
Telecommunications in Inform to 1 will result in IM and IT within this C2 factor 
being critical layers. 

Similarly removing the Inadequacy Slack associated with Transform's C2P 
layer, ie raising the inadequacy of that item from 1 to 2, will result in that item 
becoming critical and added to the set of critical layers. (In general a new critical 
item can completely change the set of critical layers.) 

These examples are simplistic and the results are evident from looking at 
Figure 3; however, the power of the technique lies in its scalability which will be 
demonstrated later. 

4.1.6 Cost analysis 

A form of cost analysis might be the determination of key areas to inject funding 
in order to remedy particular inadequacies in C2S. The MS Project representation 
facilitates this through the use of Total Inadequacy (in this case shown for the 
National Strategic model item) as an overall metric. The software enables the 
trialling of certain funding injection. 
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For example, assume a proposal was made to inject $4M to address the critical 
inadequacies identified in Figure 8. The model software enables the Inadequacy 
values of the three critical items to be set to zero and inspect the effect. The new 
critical areas of C2S would be automatically identified plus calculation of new 
Total Inadequacy and Inadequacy Cost. The result is shown in Figure 9. 
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Figure 9: Revised model ofC2 Support at National Strategic level 

The new Total Inadequacy Cost is simply the previous total minus the funds 
injected. However, the new Total Inadequacy may not be so obvious in a 
complex and higher granularity model; the automation capability that is offered 
here can potentially be a significant analysis aid. 

4.2 First cut representation of a full DOA scenario 

In order to give an initial appreciation of the scalability of the modelling 
approach, a representation of the full DOA scenario conveyed in Figures 3 to 7 is 
given in Appendix B. The environment and capabilities are identical to those 
discussed in Section 4.1. 

Figure 8 concerned the National Strategic level of command; the model detailed 
in Appendix B includes the remaining levels of command. Also incorporated is 
an item for the overall model, labelled "DOA". The critical path analysis 
identifies that "in a DOA scenario, the critical inadequacies in CIS occur at the 
Military Strategic and Tactical levels of command". The specific critical C2S layers 
for associated C2 factors are also identified within the levels of command. The 
process of conducting inadequacy and cost analysis would be identical for this 
full DOA model as that conveyed for the National Strategic level of command in 
Section 4.1. 
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The MS Project file will rapidly become large for more detailed scenarios. There 
are numerous aids for managing this including the ability to collapse the project 
so that only summary items are displayed in regions specified by the user. An 
example of this flexibility is shown in Figure 10 for the single DOA model 
detailed in Appendix B. It should be noted, however, that critical summary items 
are not highlighted which is an impediment to visualising the characteristics of 
the overall project. 
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Figure 10: Collapsed model ofC2 Support for DOA scenario 

A hierarchical representation with some flexibility in visualisation is therefore 
achievable with a single model. A more modular approach can also be employed 
using sub-projects which avoids the data visualisation limitation exemplified 
above. 

4.3 Modular representation of a full DOA scenario 

The preceding sections serve to demonstrate the model implementation 
environment and the manner in which critical path and cost analysis can be 
employed in the study of C2S. A more flexible and modular approach would 
offer benefits and this has been aspired to through the use of sub-projects (see 
Appendix A) within MS Project. The basic analysis techniques conveyed in 
previous sections still hold. The user has complete flexibility as to what extent 
sub-projects are adopted; in this section sub-projects will be purposefully used 
extensively. 

Any project, such as those presented earlier, can be referenced as a sub-project 
by another, higher-level, project. In such a case a model item within the higher- 
level project will assume the Inadequacy and other information of the sub- 
project. Critical path analysis can be applied to the resulting hierarchy. 
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4.3.1 Representing C2S primitives as sub-projects 

In order to maximise ease of reuse there is a need to employ basic C2S primitives. 
Such primitives are implemented using sub-projects. The C2S primitives are 
considered to be the C2 factors and their layers of support. An MS Project 
representation of the National Strategic Inform factor is shown in Figure 11. 
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Figure 11: Representation of National Strategic Inform factor 

The C2 factor has a generic structure. The process of producing particular C2 
factor models, such as that of Figure 11, involves copying the associated 
MS Project file, renaming and storing it in an appropriate directory if required, 
and tailoring it through revised inadequacy and unit cost values. This process 
involves minimal effort and was carried out in order to generate sub-projects for 
every C2 factor of each level of command of the DO A scenario. 

4.3.2 Employing C2S primitives to form a hierarchical DOA model 

Figure 12 shows the structure used to form an equivalent but more modular and 
flexible version of the DOA model presented in Section 4.2. 

DOA 

1 I 

NatStrat MilStrat Oper Tactical Sensor 

Transform Transform Transform Transform Transform 
Inform Inform Inform Inform Inform 

C/l C/l C/l C/l C/l 

Figure 12: Hierarchical representation of sub-projects for DOA scenario 
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The top-level DO A project is shown in Figure 13 with model items 
corresponding to the levels of command for which exist sub-projects. At this 
level the critical levels of command are highlighted through critical path analysis 
of the whole model. This permits facts such as "in a DO A scenario, the critical 
inadequacies in C2S occur at the Military Strategic and Tactical levels of command" to 
be immediately ascertained. Such abstracted facts cannot necessarily easily be 
achieved in a monolithic MS Project model. 
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Figure 13: Top-level MS Project model ofDOA scenario 

Drilling through the critical Military Strategic item presents the sub-project 
shown in Figure 14. This shows each of the C2 factors contributing to the 
criticality of the Military Strategic level owing to their sequential nature. Thus 
"the criticality of the Military Strategic level results from critical inadequacies within 

each oftlxe CIS layers" is determined. 
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Figure 14: Military Strategic sub-project of DOA scenario 
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Drilling further through this hierarchy into the Transform layer presents the 
sub-project shown in Figure 15. This C2S primitive shows that "the critical 
inadequacies of the Transformation factor of CIS occur in the C2 Framework and 
Telecommunication layers". 
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Figure 15: Military Strategic Transform sub-project of DO A scenario 

The same process can be conducted on other branches of the hierarchical model 
and exemplifies the layered analysis that this form of model permits. The above 
example concerned drilling down through critical items to further pinpoint 
sources of inadequacy. The example conveyed the use of the automatic critical 
path analysis capabilities of MS Project which are designed to look at the effect of 
a particular sub-project on the complete hierarchical model. MS Project also 
offers the ability to conduct critical path analysis on a sub-project in isolation. As 
an example consider drilling into the Transform factor of a non-critical branch 
such as the Operational level of Figure 13. This gives the model shown in 
Figure 16. 
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Figure 16: Operational Transform sub-project ofDOA scenario 

15 



DSTO-TR-0678 

It should be noted that no critical C2S layers are highlighted and that all 
inadequacy slack figures are non-zero which reflect that this C2 Factor and its 
layers of support are non-critical in the overall DOA scenario. Instructing 
MS Project to compute the critical path for this project in isolation (see 
Appendix A) gives Figure 17 which correctly identifies the IT layer as being 
critical to the Transform factor of the Operational level of command. 
(Appendix C gives some shortcomings in this area.) 
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5. Scalability: Supporting A More Detailed 
Analysis 

Preceding sections of this document have concentrated on conveying how 
MS Project can be used to represent and analyse a DOA scenario that is 
equivalent to the models presented in Phase II of the C2SS[2]. The benefits of 
using this tool for critical path analysis become more apparent with growth in 
model complexity. This section will illustrate this by applying more detail to the 
C2SS DOA scenario. It should be noted that there are probably many options for 
addressing more detail and many ways of implementing an MS Project 
representation. The requirement for and manner of possible C2SS Phase II 
scenario extensions are yet to be determined. Earlier examples conveyed the use 
of two MS Project extremes: a monolithic project and the use of sub-projects for 
each C2S factor. This section uses the sub-project breakdown shown in Figure 18 
to illustrate model design flexibility within the two extremes used earlier. 
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Figure 18: Hierarchical representation of sub-projects for detailed DOA scenario 
analysis 

5.1 Breaking up the scenario into phases 

Rather than use levels of command (Figure 12) to modularise the DOA scenario, 
the scenario is here broken up into the phases identified in reference 2. In order, 
these phases are: 

• Decision to deploy; 

• Deployment and employment in the sea-air gap; 

• Deployment and  employment in the Land area of operations  and 
redeployment planning; and 

• Redeployment. 

The top-level DOA project is hence that shown in Figure 19 where each phase 
has a corresponding sub-project. At this level (for the invented data used) "the 
critical inadequacy in C2S occurs during the Decision To Deploy phase". 

17 



DSTO-TR-0678 

' Micrusult Prujeul - D0A2 MPP 

l»l»l'>l-^^^11 Tasks j^JI |Arial jjgfs     j^jl^^gllgi 

Hero Najtia 

ill 

1 Ina'rteq 1 Slack 1'flwlt^C^B'^Wj;;'?»'l»,y^^^Sfe ^-fff-ttly .y^f ■••'i]^^^ 

til?- Decision to Deploy                  9g 
r-3'- Deploy & Employ SA                       j    7d 

4 Deploys. Employ LAO/Redeploy Pi!    Bd 
5 F - deployment \    5d 
G"        i  

2d 
'id 
"4d"' 

512,840 

136.800 
55.500 
19220 

JÜ 
'< i    "' * ,' * t       >  J   ! Vv *^~J  >.t    _ 

Figure 19: Top-level MS Project model ofDOA scenario 

5.2 Representing phases of operation 

Representation of each phase in this example demonstrates the variable depth of 
detail that can be accommodated. As shown in Figure 18 the Decision to Deploy 
phase is represented in most detail; Figure 20 shows the project representation 
consisting of 4 sub-projects corresponding to the Indicators and 
Warnings (I&W), option development, government appreciation and ADF 
tasking stages. At this level "the Decision to Deploy phase is critical oxving to 
inadequacies in the Option Development stage" can be determined. 
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Figure 20: The decision to deploy phase of the DOA scenario 

The sub-project for the I&W stage is shown in Figure 21; as shown in Figure 18 
this is the lowest level for this branch of the DOA tree structure. Hence the C2S 
primitive in this case is a representation of all three C2S factors as used in the 
initial model of Figure 8. No items are highlighted as critical since the I&W stage 
is not critical to the overall DOA scenario; again, manual calculation options are 
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available to inspect criticalities local to  the I&W stage.  The  Government 
Appreciation and ADF Tasking stages are represented in an identical manner. 
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Figure 21: The I&W stage of the DOA scenario 

Whilst C2S for the I&W stage is summarised through the use of factors at that 
level, the Option Development stage is represented in further detail by 
consideration of each of the key ADF agencies involved (Figure 18). The sub- 
project for this stage is shown in Figure 22 which has sub-projects for each of the 
ADF agencies concerned. At this level it can be determined that "the Options 
Development stage is critical owing to inadequate CIS of the contributions of CDF and 
COMAST". 
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Figure 22: The Option Development stage of the DOA scenario 

The degree of C2S for each of the agencies shown in Figure 22 is represented in 
the manner shown in Figure 21. 
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The use of sub-projects for the remaining branches of the DOA hierarchy is as 
shown in Figure 18. The Redeployment phase is represented through the use of 
separate sub-projects for each of the C2 factors as presented in Section 4.3.2. 

6. Summary and Discussion of Capabilities 

The use of Petri nets (PN) and project management tools have been investigated 
for providing a critical path capability to the analysis of C2S inadequacy 
identified in the C2SS. The use of PN generates linkages to other analysis 
capabilities such as simulation and access to explanation and analysis tools [3]. 
Critical path analysis, however, is a secondary or spin-off capability of PN and 
hence for the PN tools considered is not supported by a user friendly 
environment. Also, additional PN attributes plus associated functions would 
need to be introduced in order to conduct cost analysis. Critical path and cost 
analysis are typically intrinsic features within commercial project management 
tools. Use of such a tool is therefore preferred and MS Project was chosen for this 
investigation owing to its availability and user familiarity. 

Use of MS Project provides an ability to: 

• Construct a hierarchical representation of an ADF scenario or structure 
with associated C2S inadequacy values and cost. 

• Employ a flexible model design through the use of sub-projects and C2S 
primitives. 

• Automatically generate and visualise critical areas of C2S inadequacy at 
various levels of abstraction in the model hierarchy. 

• Vary inadequacy values and cost for the purposes of cost-benefit and 
other analysis. 

A quantitative analysis technique has been applied to qualitative data. The 
assumption was made that two values of inadequacy can be quantitatively 
compared. 

There are a number of identified shortcomings associated with the use of 
MS Project and critical path analysis to C2S. Some of the weaknesses may be 
addressed through the use of macros; this has not been fully investigated to date. 

• Sub-projects  require  separate  MS Project files,  each  with  associated 
overheads in size. 

• The critical path algorithm when applied to individual sub-projects has 
some limiting but manageable anomalies (see Appendix C); 
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• Apart from guaranteed common C2S primitives such as the C2S factors, 
no arrangement of model items in sequence is permitted (see 
Appendix C). 

• Adequacy relates to Duration for which the most convenient unit was 
days. However, no means of removing the 'd' from Inadequacy entries 
could be found. 

• Drilling down and working up a particular branch of a model hierarchy 
can be achieved with ease in MS Project through successive opening and 
closing of files. In general traversing the hierarchy laterally creates 
confusion regarding location in a complex model. The PERT Chart view 
was investigated but is regarded as requiring too much manual 
adjustment to make it user friendly and does not offer any additional 
features over the Gantt Chart view. 

• Use of the macro to compute inadequacy cost is completely manual; no 
mechanism for automating this could be found. 

The nature of further analysis within the C2SS is yet to be clarified. One 
example of how more detail could be introduced is: 

• Rather than using levels of command, break down a scenario into the 
various operational phases and stages therein; 

• Introduce the specific agencies associated with a scenario for which C2S 
is required (a level of command view could maybe be introduced here if 
really needed); 

• Introduce specific systems such as CSS and telecommunications 
associated with the provision of C2S. 

If a stochastic presence arises (eg assigning inadequacy values with some 
degree of uncertainty) then a PERT technique (or simulation equivalent[4]) or 
Petri net simulation may then become more appropriate. Petri nets also offer the 
flexibility of designing a single C2S model that enables both time-based and 
other (eg inadequacy-based) analysis to be conducted simultaneously. 

The analysis capability offered in this report would be greater and more 
evident if a larger range of values (compared with 0,1,2 and 3) for inadequacy 
were used in the C2SS. The inadequacy cost functions used assume a linear 
relationship between cost and inadequacy. A more complex function could be 
employed through the use of macros. 

7. Conclusions 

An ability to apply critical path analysis to the study of C2 Support has been 
demonstrated. The use of MS Project as a candidate tool for such analysis has 
been conveyed through the use of a Defence Of Australia scenario. Scenario data 
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indicative of that resulting from the current C2 Support Study has been used to 
illustrate the benefits in data management, reporting and analysis of applying 
this capability. 

This report is the result of an initial effort to identify opportunities for 
supporting the C2SS, or some post-study activity, with more quantitative 
analysis using modelling and simulation. 
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Appendix A - Key MS Project Utilities 

This appendix will describe only those MS Project utilities whose employment is 
mentioned in the main text. It is not intended to provide a detailed user guide 
but rather pointers from the main menu and other locations to appropriate areas 
in the commercial product. 

Al        Environment 

All      View 

A View of Gantt Chart should be assumed unless stated otherwise. 

Main Menu:      View -> Gantt Chart 

Al.2     Table 

The custom designed InadequacyCost should be assumed unless stated 
otherwise. 

Main Menu:      View -> Table -> InadequacyCost 

A2       Critical path generation 

The manner in which the critical path is generated is achieved via the 
Calculation facility. 

Main Menu:      Tools -> Options -> Calculation 

Automatic calculation should be chosen. 

The "Calculate All Projects" option will show the current sub-project's critical 
path based on the relation of that sub-project to any predecessor item or sub- 
projects) within the model hierarchy. That is, a one step look-back. This is the 
default setting if Automatic calculation is set. (See Appendix C for further 
information regarding this capability.) 

The "Calculate Project" button will show the current sub-project's critical path 
based on the characteristics of that sub-project alone. 

A3        Sub-project creation 

An existing project can be linked into another project as a sub-project: 

- Create a model item in the higher-level project that will correspond to the sub- 
project. 
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- Create link to sub-project: 

Main Menu:      Insert   ->   Task   Information   ->   Advanced   ->   Sub-Project 
(Browse) 

A4       Inadequacy cost macro 

The CalcInadeqCost macro can be activated using the: 

<ctrl>T 

hot key or via the following main menu facilities: 

Main Menu:      Tools -> Run CalcIndeqCost 

Main Menu:      Tools -> Macros 
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Appendix B - Single Project Representation of 
DOA Scenario 

The single project representation of the DOA scenario described by Figures 3 to 7 
is shown in Figure Bl ((a) to (d)). The model is discussed in Section 4.2. 
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Figure Bl(a):        MS Project representation ofC2 Support for DOA scenario 
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Figure Bl(b):        MS Project representation ofC2 Support for DOA scenario 
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Figure Bl(c):        MS Project representation ofC2 Support for DO A scenario 
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Figure Bl (d):        MS Project representation ofC2 Support for DO A scenario 
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Appendix C - Shortcomings In MS Project Critical 
Path Analysis 

Cl        Critical path generation in hierarchical projects 

There are apparent shortcomings in MS Project regarding the built-in critical 
path analysis capabilities for hierarchical projects. Whether activated 
automatically or manually, for any project or sub-project there are two modes of 
application for critical path analysis (see Appendix A for user instructions). 

• The "Calculate Project" button will show the current sub-project's critical 
path based on the characteristics of that sub-project alone. 

• The "Calculate All Projects" option (the default automatic option) will 
show the current sub-project's critical path based on the relation of that 
sub-project to any predecessor item or sub-project(s) within the model 
hierarchy. That is, a one step look-back. This appears contrary to the 
description of the capability which implies an ability to show what items 
in the current sub-project are part of the critical 'path' of the complete 
project. An example of the consequences of this apparent deficiency when 
drilling down the hierarchy from a non-critical top-level model item 
follows. 

The sub-project for the National Strategic (a non-critical level as shown in 
Figure 13) level is shown in Figure Cl. No items are critical which is expected 
since the top-level item is non-critical also. 
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Figure Cl:   National Strategic level sub-project for DO A scenario 

Drilling down further into the Transform C2 factor of this stream gives the sub- 
project shown in Figure C2. Again no items are critical as expected. 
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Figure C2:   National Strategic level Transform factor for DOA scenario 

Returning to the National Strategic level of Figure Cl but this time drilling 
down into the Inform stream gives the sub-project of Figure C3. The 
Telecommunications layer is highlighted as critical. This item is evidently not 
critical to the overall DOA scenario but has been highlighted because it is has a 
predecessor, namely the National Strategic Transform sub-project of Figure C2. 
Each of the other example sub-projects shown in this appendix have no 
predecessors. 
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Figure C3:   National Strategic level Inform factor for DOA scenario 

The "predecessor problem" would appear to be a limitation in the algorithm 
and maybe even a software 'bug'. Item3 in Figured shows an Inadequacy 
value of 3 and an associated slack of 1 which is correct in that addressing that 
slack by raising the Inadequacy to 4 would make the Inform factor critical within 
the complete project. Item 1 in Figure C3, however, shows a correct Inadequacy 
of 3 but a slack of zero. This would seem to imply that the sub-project has a local 
focus or at most a one step look-back only and not a project wide focus. 

The identified shortcomings are not considered prohibitive to the study of C2S 
and can be managed if the following rules of use and interpretation are 
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employed. The shortcomings can be completely avoided if sequences of model 
items are not permitted (see Section C2). 

• If a top-level project item is critical then the answer to the question "Why" 
can be addressed through drilling down through the corresponding 
hierarchy of sub-projects (see earlier example). Lower-level critical items 
will be identified. 

• If a top-level project item is non-critical then drilling through the 
corresponding hierarchy of sub-projects will not show non-criticaHty 
throughout. Any items shown as critical should be interpreted as being 
only critical locally and not throughout the entire project. 

• The interpretation of any changes in criticality that might occur due to 
experimentation on lower-level project data should always be determined 
through top-down verification. 

C2       Issues concerning variable depth 

The detailed DOA model used in Section 5 is an example model with varying 
depth of detail (eg the Decision to Deploy branch compared with the 
Deployment & Employment in Land Area of Operations branch). It would be 
useful to organise phases and stages in the sequence that they occur in the 
scenario. For example, I&W followed by Option Development then Government 
Approval then ADF Tasking. The inadequacy of each phase would be the total of 
the stages within, and the inadequacy at the DOA level the total of the phases. 
This results in an imbalance. 

Preserving the order of the DOA phases and stages would result in the 
Decision to Deploy node having a maximum inadequacy value of 36 compared 
with that of 9 for the 'Dep Emp LO' node. This would give misleading results 
when trying to identify inadequacy 'hot spots'. 

The only items that are arranged in sequence in the DOA model of Section 5 
then are the C2 factors. This is possible since the C2 factors are common 
primitives and all C2S models have the three factors in sequence. The 
inadequacy value of any node in the model tree structure will always be at 
most 9. 

Forcing concurrent model items generally helps the application of critical path 
analysis. All sequential items along a critical path are critical even though some 
items may have a far lesser inadequacy than others. Forcing concurrent items 
means that those with the highest inadequacy can be identified within what 
would otherwise be an order to items, resulting in greater granularity to the 
analysis capability. (It should be noted that representing the C2S factors as 
concurrent factors has the same benefit and also circumvents the MS Project 
limitations discussed in Section Cl. However, the sensitivity of the model is then 
reduced owing to all nodes now having a maximum inadequacy of 3 rather 
than 9.) 
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